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Viewing a Recipe

To view the recipe for a drink, simply click on its name in the drink 
list.    Use the scroll bar on the right side of the drink list to move up and 
down in the list.

You can also use the keyboard to move through the drink list.    Using 
the up and down arrows will move up and down one drink at a time.    Using 
the page up and page down arrows will move a full page of drinks at a time.



Changing your View

In BarBack, a view is a way of organizing the drink list.    BarBack has 
six different views, or six different ways of organizing your drinks.    They 
are:

The Name View Lists all of the drinks alphabetically by name

The Liquor View    Lists all of the drinks by the first ingredient of the 
drink.    In this view, what you see in the list is each separate liquor or 
ingredient.    By clicking on that ingredient, the list expands to show the 
drinks that use that ingredient.

The Glassware    View    Lists all of the drinks by the recommended 
glassware.    In this view, what you see in the list is the name of each type of 
glass.    By clicking on the name of a glass, the list expands to show all the 
drinks that use that glass.

The Category View    Lists all of the drinks by the category or type of 
drink.    In this view, what you see in the list is the name of each category or 
drink type.    By clicking on the category, the list expands to show all the 
drinks in that category.

The Marked View    Lists all of the drinks that are currently marked.    
In this view, what you see is similar to the name view, but is limited to 
marked drinks and the icon has a red check mark on it.

The Liquor Cabinet View    Lists all of the drinks that can currently be 
made.    In this view, what you see is a colored icon next to the name of the 
drink.    Green means that you have all the ingredients to make that drink, 
yellow means that you are missing one ingredient and red means that you 
are missing two ingredients.

To change the view, click on the view menu at the top of the window 
and select the view you prefer.    

If you had done a search and were currently showing the results of 
that search in your drink list, changing the view will cause you to lose your 
search results and go back to showing all drinks.



Searching

There are six different ways to search through the drink list to find the
recipes youre looking for.    

Name Search    This will match all or part of the name of a drink.    You 
can choose to match all instances or to only match the first letters.    For 
example, suppose you enter rum as the text to search for.    If you choose the 
Match All Instances option, then you will get a list of drinks including Rum 
Runner and Bermuda Rum Swizzle.    If you choose the match first letters 
only option, you would get the Rum Runner but not the Bermuda Rum 
Swizzle because it does not start with the word rum.

Ingredient Search  This will match all or part of the name of an 
ingredient and give you a list of all drinks that contain the matching 
ingredients.    The Match all instances and Match first letters only options 
work the same way as they do when searching by name.

Recipe Search    This will match all or part of the recipe of a drink and 
give you a list of all drinks with recipes that match the text you are 
searching for. The Match all instances and Match first letters only options 
work the same way as they do when searching by name.

Glassware Search  This will search for drinks that use the glass that 
you select.    This search is will give you a list of glasses to choose from and 
will then show all the drinks that use that glass.

Category Search  This will search for drinks that fall into the category
that you select.    This search will give you the current list of categories to 
choose from and will then show all the drinks that fall into your selected 
category.

When you are finished with the search and want to restore the drink 
list to showing all of the drinks, use the Show All Drinks command found 
under the View menu.    This will reset the drink list to show all of the 
available drinks.    This will not effect your current view.



Adding a Drink

To add a drink, choose the Add command from the Edit menu. The 
keyboard shortcut for this command is Ctrl-A.    Drinks can only be 
added when you are in the Name View.    After choosing this 
command, a dialog will appear where you can enter information 
about the new drink.    Here is the process step by step:

1. After the dialog comes up, enter the name of the drink.    The drink 
name that you enter must be different from all the other drink 
names.    Each drink must have a different name.

2. Now you need to add the ingredients.    To do this, you can either 
right-click on the ingredients list, or you can click on the Add 
Ingredient button.    Both of these actions will bring up the Enter an
Ingredient dialog. 

3. To enter an ingredient, you first must select the name of the 
ingredient.    The ingredient can either come from 

the list of existing ingredients, or it can be a new ingredient name 
that you type in.

4. After you select the ingredient, you then need to enter the amount. 
The amount should be entered as a decimal number.    For example,
enter 1.5 instead of 1 ½.    This will recognize any international 
settings you may have for the decimal place.

5. After you have entered the amount, you should now select the 
units.    There are 20 different units you can choose from, including 
metric, English and bar measurements as well as ambiguous 
measurements, such as Part or Piece, that depend on the size of 
the glass or the type of ingredient.    After you have selected the 
units, click on the OK button.    You will now see your ingredient 
entered in your list of ingredients for the new drink.    To add more 
ingredients, repeat this process.    The ingredients for your drink 
will always be displayed in the order that you enter them and there
is no limit to the number of ingredients you can have in a single 
drink.

6. As you enter the ingredients, if the ingredient price had been set, the 
cost of that ingredient is shown above the ingredient list.    If you select a 
different ingredient, the cost is updated to display for the selected 
ingredient.    
7. If you have Drink Price settings in place (either through the options 
dialog, or through the Drink Price Worksheet), then the calculated drink 
price will appear in the space provided.    If you do not have any price 
settings in place, you may set the rules for drink price markup and other 
price settings by clicking on the Price Settings button.    If you are not 
concerned about the drink cost or price, then you can ignore this part.    
8. If you want to set your own drink cost and price, you can enter them 



in the spaces provided after you are finished adding all the ingredients.    If 
you add or remove an ingredient, the price and cost will be automatically 
recalculated and will replace what you entered.
9. After entering all the pricing information (if you chose to do so) you 
now need to select a drink category.    The Drink Category combo box 
contains a list of all of the currently available drink categories.      If you 
want to add, change or remove any of the categories, see the section titled 
Working with Drink Categories
10. Now you can enter the drink recipe in the space provided.    The 
recipe can be as long as you want it to be up to 32,000 characters.
11. The final step to adding a drink is the selection of the glassware.    
Click on the Glass Type button to bring up a list of the available glasses and 
containers.    Choose the one you want and click on OK.    
12. You are now finished entering this drink.    Click on OK and the drink 
will be added to end of the drink list.    It will appear in its proper sorted 
position the next time you change your view or do a search.    
13. Note that the Add Drink dialog is still up, but has been cleared out.    It
is now ready for you to enter another drink.    If you want to add another 
drink, start this process all over again.    If you are finished entering new 
drinks, then click on the Cancel button.



Edit a Drink

To edit a drink, choose the Edit option from the Edit menu.    The 
keyboard shortcut for this command is Ctrl-E.    Drinks can only be edited 
when you are in the Name View.

This command will bring up a dialog that is exactly the same as the 
Add A Drink dialog.    Here you can make whatever changes you want, 
changing the name, ingredients, price, category, recipe or glassware.    Once
you click the OK button, all your changes are saved.    For details on how to 
use the dialog, see Adding a Drink.



Delete a Drink

To delete a drink, choose the Delete option from the Edit menu.    
When you do this, a warning will appear asking if you are sure that you 
want to delete this drink.    After being deleted, the drink is lost. There is no 
way to undo the command except to add the drink again as a new drink.



Printing

Printing Formats

BarBack can print a list of drinks in any one of 
three formats.    

Condensed Format  This format will print drinks in alphabetical 
order in a single column on the page in portrait mode.    
Usually, between 5 and 7 drinks fit on a page.

Booklet Format  This format will print drinks in alphabetical 
order in two columns, with the page in landscape mode.    
Usually, between 10 and 12 drinks fit on a page.

Index Format  This format is designed to print index cards and 
only prints one drink per page.    You must specify the size of 
the page when you select this mode.    It is recommended that
you test printing in this mode with a single drink and adjust 
the orientation and paper size before you print large batches 
of cards.

Index Card Format  This format is designed to print index cards 
in a standard 8.5 x 11 sheet with three cards per sheet.

Large Rotary Card Format  This format is designed to print 
rotary (rolodex) cards in a standard 8.5 x 11 sheet with three 
cards per sheet.

Small Rotary Card Format  This format is designed to print 
rotary (rolodex) cards in a standard 8.5 x 11 sheet with six 
cards per sheet.

Business Card Format  This format is designed to print on 
business cards in a standard 8.5 x 11 sheet with ten cards 
per sheet.

Printing

To print drinks, choose the Print option from the File menu.    The 
keyboard shortcut for this command is Ctrl-P.    

This command will bring up the Print Drinks dialog.    

To print the drinks you want, follow these steps:



1. Choose the printer you want to use.    The printer that you have set 
in Windows as the default printer is the default printer selected 
here.    If you want to use another printer, select it from this list.

2. If you want to, you may enter a title for this report.    The title will 
appear at the top of every page.    If you do not want a title, leave 
this part blank.

3. Select the drinks you want to print.    There is a list that displays all of 
the drinks that were displayed in your drink list when you selected the print
option.    To select individual drinks in the list, simply click on each drink 
that you want to print.    That drink will become highlighted and the count of
selected drinks on    the right will increase.    To deselect a drink, just click 
on it again and the highlight will go away.    If you want to select all of the 
drinks in the list, there is a button to the right of the list labeled Select All.   
Clicking on it will highlight all of the drinks in the list.    If you want to clear 
all of the selections you made, you can click on the Clear Select button and 
all the drinks that were highlighted will be cleared. 
4. Select the format that you want to list to be printed in.    Select the tab
labeled Format. See the Print Formats section above for details on each of 
the three formats.    Remember that if you select the Index Format, you must
enter the size of your paper.
5. Select the tab labeled Options to change some of the print options.
6. Now make sure that your printer is on and it has paper then click on 
the OK button.

Printing Marked Drinks

To print marked drinks, select the Print Marked Drinks option from
the print menu.    The print dialog will appear just as it does for normal
printing, but the drinks that are available in the drink list are only 
those that are marked.



Marking & Unmarking Drinks

The Drink marking feature is also new to version 5.0.    Marking allows
you to quickly get back to a drink that you like or that you thought might be 
interesting.    

Marked drinks can be viewed using the View Marked view and can be 
printed using the Print Marked Drinks command.

In the lower right corner of the BarBack screen there is an icon and a 
button.    The icon is a picture of a drink when the drink is not marked and is
a picture of a drink with a red check mark when the drink is marked.

Marked Unmarked
Drink Drink 
Icon Icon

To mark the drink, click on the Mark Drink button.    If the drink is 
already marked, the button label will read Unmark Drink and clicking on it 
will unmark the drink.    The keyboard shortcut for this command is Ctrl-M 
to both mark and unmark the drink.

Mark All

By choosing Mark All from the Mark menu, you can mark all of the 
drinks in the current list.    Only the drinks currently in the drink list will be 
marked.

Unmark All

Choosing Unmark All from the Mark menu will unmark any marked 
drink.    This will effect drinks that are not currently visible in the list as well
as those that are.

Convert to Category

This will allow you to take all of the drinks that are currently marked 
and convert them into a category.    You can use an existing category or 
create a new category.



Preferences and Options

BarBack has three options that it remembers after the program is 
shut down: Ingredient Highlighting, the Default View, and the Price 
Settings.

Ingredient Highlighting

The Ingredient Highlighting option allows you to display ingredients 
that you do not currently have in a different color from the ones that you do 
have.    BarBack uses the information entered in the Liquor Cabinet section 
to determine what ingredients you do and do not have.

If you uncheck the Highlight missing ingredients checkbox, the 
highlighting will be turned off and all ingredients will be listed in the default
window text color (usually black).    If you leave the box checked, you can 
then click on the raised color box next to the checkbox.    This will bring up a
color selection dialog where you can select the color you want the missing 
ingredients to be highlighted in.

Default View

If you want BarBack to always start up in a particular view, you can 
select that view here.    If you want BarBack to come up with the view that 
was most recently used, select the bottom option Default to most recently 
used view.    This will bring BarBack up with the last view that you were 
using.    BarBack does not remember any searches that you had when it was 
shut down.

Metric or English Measurements

In version 5.0 you can now select between displaying drinks in metric 
units or in English units.    Drinks that were entered in metric units 
originally will not be displayed in English units.    Also, drinks that do not 
use units or use generic units (such as 1 Part this, 2 Parts that) are also not 
converted.

Price Settings

BarBack maintains several settings that are used to calculate drink 
prices.    By clicking on the Price Settings button, you can bring up a dialog 
where you can change those settings.    

The drink price settings are used when you are adding a new drink to 
automatically calculate the price of the drink based on the cost of the 
ingredients.    The price settings are also used by the Prink Price Worksheet 



when setting prices for all drinks.
For more details on using the drink price settings, see the Using the 

Drink Price Worksheet PRICE section.



The Liquor Cabinet

The Liquor Cabinet will allow you to select all the ingredients that you
have on hand and will then generate a list of all the drinks that you can 
make. 

Open Ingredient List
This is for compatibility with BarBack version 3.0.    If you had saved 

an ingredient list under BarBack 3.0, you may open it with this option.    The
concept of saving a liquor cabinet list does not apply anymore in version 5.0
since all the selected ingredients are stored internally.

Selecting Ingredients
To select an ingredient, double click on the ingredient in the left hand 

list.    You can also highlight the ingredient and click on the button with the 
arrow pointing to the right.    This will move the ingredient to the right hand 
list, indicating that you currently have that ingredient.

Unselecting Ingredients
To remove an ingredient from the selected list, simply double click on 

it.    It will be removed from the selected list and replaced into the available 
list.    You can also highlight the ingredient and click on the button with the 
arrow pointing to the left.

Drink Matching Options
BarBack version 5.0 now gives you the option to have inexact matches

for possible drinks.    BarBack will let you match drinks with one or two 
missing ingredients.    Liquor Cabinet matches are color coded as follows:

    Green indicates an exact match. All of the ingredients that are 
necessary to make the drink you have indicated that you have.

    Yellow indicates that one ingredient is missing.    There is one ingredient
still needed that you do not have selected.

    Red indicates that there are two ingredients missing.    The drink 
requires two more ingredients that you do not have in order to complete the
drink.    This will not show any drink where you do not have any of the 
ingredients.    For example, if a drink requires two ingredients and you do 
not have either of them, then the drink could get a red dot, but BarBack will
not select it at all.

Ingredient Highlighting
See the Setting your Preferences and Options section for details on 

how to change the ingredient highlighting.



Status
After you have selected all of your ingredients and clicked on OK, the 

status area will become active.    It shows the name of the current drink 
being checked and gives a running total of the number of matches it has 
found so far.    The matches are separated by their color.

Canceling
While the Liquor Cabinet feature is busy mating drinks, you can click 

on the cancel button at any time to interrupt it.    Any matches it had found 
up to that point will still be kept.

Finally, when the Liquor Cabinet is finished checking all the drinks, 
you will be returned to the main BarBack screen with the drink list in a 
special mode.    This mode is a cross between the name view and the liquor 
cabinet view.    All the drinks are arranged in alphabetical order, but with a 
colored dot next to each to indicate its liquor cabinet status.    To arrange 
the drinks by their liquor cabinet status (green, yellow, then red) select the 
Liquor Cabinet view from the View menu.



The Shopping List

The Shopping List is a feature of BarBack that allows you to select 
drinks and the approximate number of drinks that you plan to make and 
from that information, create a shopping list with all of the different 
ingredients used by your selected drinks and the amounts of each that you 
will need.

The available drinks are in the list on the left and the selected drinks are in 
the list on the right.    To add a drink to the selected list, you can double 
click on it, or you can highlight it and click on the -> button.    The <- button
removes the drink from the selected list as does double clicking on the drink
in the selected list.    The 
->> and <<- buttons move the entire drink list to and from the selected 
side.    You can highlight more than one drink at a time and use the -> 
button to add or remove them.

Estimating The Number of Drinks

An average person that drinks will have between 2 and 5 drinks at a 
party.    This is based on personal observation and not on any statistical 
information that I know of.    When entering the number of drinks, I use this 
equation:    Take the number of guests that you expect, multiply that by the 
number of drinks you expect each guest to drink (on average), then divide 
that by the number of drinks that you have selected.

This is only a rough estimate of course.    You will have to use your 
best judgement as to the popularity of certain drinks over others and the 
drinking capacity and habits of your guests.

Measurements

Once you have selected the drinks you want, and estimated the 
number of drinks, then you can select the type of measurements to use.    
The measurements are in Bar (Fifth, Pint, etc...), English (Gallon, Quart, 
Pint, etc...) and Metric (Liter and milliliter).    Pick the one that you feel is 
appropriate for where you will shop.

Make List

Clicking on Make List will generate the shopping list.    If you change 
any of you settings, clicking on Make List again will update the shopping 
list.

Clear List



This will clear the list of selected drinks.

Print

This will print your shopping list.    You also have the option of printing
the recipes for the drinks you selected as well.

Save List

Once you have the shopping list the way you want it, you can save it.   
The default extension for a saved shopping list is .LST.

Open List

If you want to bring    up a previously saved shopping list, you use the 
Open List button and browse until you find the shopping list you are looking
for.    This will read in the list, set the selected drinks, set the estimated 
number of drinks and set the measurement method for you.    You can then 
print or change any of the settings.



Setting and Changing Ingredient Types

There are over 5500 drinks in BarBack with over 900 different 
ingredients.    To help organize this list of ingredients, the list is broken 
down into categories or types much like the drink list is.    The ingredient 
types are completely customizable.    You can add edit and delete any of the 
types with only one exception.    You cannot delete the Undefined / Other 
type.    This type is used internally by BarBack and must be present.    You 
can change its name if you want though.

To change the ingredient types, you use the Ingredient Type dialog 
which is under the Edit Ingredient Types command in the Tools menu.

To change the type of an ingredient, select the ingredient you want to 
change from the list at the top.    Then select the new type from the combo 
box at the bottom.    The ingredient will be updated automatically.    To 
customize the ingredient types TYPES use the Edit Types button



Customizing Ingredient Types

To change the ingredient type, click on the Edit Types button.    This 
will bring up a dialog where you can change the ingredient types.

Changing an Existing Type
To change an existing ingredient type, highlight that type in the list at 

the top.    The type will be displayed in the edit control at the bottom.    Make
the changes that you want in the edit control and then click on the Update 
button.    The ingredient type will be updated with your changes.

Adding an Ingredient Type
To add a new ingredient type, enter the description of the type in the 

edit control at the bottom.    Then click on the Add button.    This will append
the new type to the end of the list.    After adding a type, you will then need 
to associate ingredients with the new type.    This is done in the Ingredient 
Types dialog.

Removing an Ingredient Type
To remove an ingredient type, highlight the type that you want to    

remove and click on the Remove button.    This will take the type out of the 
list.    It will also set any ingredients that use that type to be changed to the 
Undefined / Other type.    you will then need to go back to the Ingredient 
Types dialog and change the Undefined / Other types to another type (if you
want to).    Please note that the remove cannot be undone.    If you remove an
ingredient type and then add that type back again as a new type, all of the 
ingredients that were made undefined when you deleted the type will still 
be undefined, so use this carefully.



Setting Ingredient Prices

BarBack has the ability to set a drinks price based on its cost.    To 
determine that cost, BarBack must know the cost of the ingredients.    This 
is how BarBack knows the cost of each ingredient.

To bring up the Ingredient Prices dialog, choose the Edit Ingredient 
Prices option from the Tools menu.

To set the cost of an ingredient, select the ingredient from the list of 
ingredients.    Then select a unit type from the combo box.    If the unit type 
you want is not listed, you can simply type it in.    Then, enter the number of 
ounces or pieces per unit.    If this is a fluid measure, it must be in fluid 
ounces.    If you use a unit type that was entered before, the number ounces 
per unit is filled in automatically.    If this is a new unit type, enter the 
number of ounces.    Afterwards, the unit type will appear in the list of types 
and the number of ounces that you entered will fill in automatically.

The Ounces edit control represents a fluid measure or a dry measure 
depending on the ingredient.    For example, a 2 liter bottle holds 67.6 fluid 
ounces.    If the ingredient was say Lemon Wedge, then the unit would be 
one lemon (or a dozen lemons or a pound of lemons) and the number of 
pieces would be the number of lemon wedges you can get out of the one 
lemon (or dozen or pound).

Finally, enter the cost of the ingredient for the unit that you selected.   
This space supports international currency formats.

Once all of the information is entered, click on the Update Ingredient 
button.

Convert Metric / English
This button will bring up the unit conversion tool that is built into 

BarBack.    You can use this to convert your units into fluid ounces for use 
here.    For more information on using the unit conversion tool, see the 
section labeledUnits Conversion and Reference
 



Drink Categories

BarBack organizes drinks into several different categories.    The Drink
categories work much the same way the ingredient categories do.    To 
change a drinks category, edit the drink as described in the editing a Drink 
section.    To add or remove categories or to change the description of a 
category, choose Edit Drink Categories from the Tools menu.

Changing an Existing Category

To change an existing drink category, highlight that category in the 
list at the top.    The category will be displayed in the edit control at the 
bottom.    Make the changes that you want in the edit control and then click 
on the Update button.    The drink category will be updated with your 
changes.

Adding a Drink Category

To add a new drink category, enter the description of the category in 
the edit control at the bottom.    Then click on the Add button.    This will 
append the new category to the end of the list.    After adding a category, 
you will then need to edit any drinks that you want to have use that 
category and change their category to the new one you just added.

Removing a Drink Category

To remove a drink category, highlight the category that you want to    
remove and click on the Remove button.    This will take the category out of 
the list.    It will also set any drinks that use that category to be changed to 
the Undefined / Other category.    you will then need to go back and edit the 
drinks with the Undefined / Other category.    Please note that the remove 
cannot be undone.    If you remove a drink category and then add that 
category back again as a new one, all of the drinks that were given 
undefined categories when you deleted the category will still be undefined, 
so use this carefully.

Categories

Blended & Frozen - drinks that are made in a blender, or are served frozen.    
Example:    Frozen Margarita.
Cocktails - traditionally drinks that are made exclusively from liquor without any 
mixers such as juice or soda.    Example: Martini.
Hot Drinks - drinks that are served hot.    Example, Irish Coffee or Hot Buttered 
Rum.
Liqueurs & Extracts - recipes for liqueurs or other items that are not necessarily 



drinks.    Example:    Glogg Extract or Apple Wine.
Mixed Drinks - basic drinks that are a combination of one or more liquors with 
mixers such as juices or soda.    Example: Screwdriver.
Non-Alcoholic Drinks - drinks that do not contain alcohol.
Punches & Party Drinks - drinks where the recipe creates more than one serving 
or uses a punch bowl or pitcher.
Shots, Shooters & Slammers - drinks that are meant to be drunk in a single 
swallow.    Includes Poussé Cafés and layered drinks as well as shooters.
Specialty Drinks - Drinks that I thought were unique or appropriate for use as a 
house special.
Unknown / Other - Just what it says.    Drinks that could not be classified any 
other way.



The Drink Price Worksheet

The drink price worksheet is used to set the prices of all drinks at 
once.    It is also used to update the drink costs when the ingredient prices 
are changed.

Percent Markup

This option sets the drink price as a percentage markup from the cost.
For example, if a drink costs $1.04, a 100% markup would make the price 
$2.08.    If you want drink prices to be equal to the cost, you can enter 0 as 
the percentage.    

Percent Increase

This option allows you to set the price as a percentage of the current 
price.    For example, if a drink is currently priced at $3.00 and you apply a 
percent increase of -50%, the new price will be 50% lower then the current 
price or $1.50.    Negative numbers indicate a markdown and positive 
numbers indicate a markup.

Apply only to drinks with a price of 0

This option allows you to only set the price of drinks that have not yet 
been set.    If the drink price has not been set and is still 0, then this will 
apply the new drink price.    If the drink price has    already been set then it 
will be left alone.

Round calculated prices to 

This combo box lists six possibilities for rounding the drink price.    
You can round the price to the next Dollar (or whole unit of 
currency), .50, .25, .10, .05 or .01.    The last option really means dont round
the price at all.    The drink price is always rounded up and is presented 
using the international settings found in Windows for currency symbol and 
format.

Force minimum price

This option has two parts.    First is the check box which indicates if 
you want a minimum price or not.    If the box is unchecked, then whatever 
is entered in the edit control is ignored and no minimum price is applied.    If
the box is checked, then the price that is entered in the edit control is used 
as a minimum price for all drinks that are being set.    The minimum price 
must be greater than or equal to 0.



Recalculate Costs

This will go through all the drinks and add up the costs of all the 
ingredients.    This should be done before updating the drink prices, 
especially if you have changed any of the ingredient prices.

Update Prices

This will go through all the drinks (or only those with a price of 0) and
will update the price, applying the rules that you have set.



Exporting the Drink List

NOTICE: This feature is provided for your convenience.    This drink list is copyright 
© Paul Knorr and cannot be reused without permission.    This includes use in another 
bartender's database program, printed book, or posting on the Internet.

The drink list is, of course, the heart of BarBack, but I realize that 
there are other things that you might want to do with it that BarBack does 
not yet support.    To handle these situations, it is possible to export the 
drink list in a format that can be manipulated by a database or spreadsheet 
program.    There is also an export option that exports the list in a format 
appropriate for a word processor.

ASCII Text Format

This format creates a single large text file with a listing of all the 
drinks.    The file contains the name, ingredients, glassware, category, price, 
cost and recipe of each drink with a blank line between drinks.

Comma Separated Values (CSV) Format

The CSV format is a standard format that can be read by almost any 
database or spreadsheet program.    When BarBack exports the drink list in 
this format, it exports the database tables directly.    What you see in the 
files does not look like drink recipes until you put the parts back together 
again.    The CSV format export creates three separate files, one for each 
table.    The files are: Drinks.CSV - Contains information about each drink, 
including the ID, name, glassware, recipe, category, price and cost.    This 
file has one record for each drink.

Ingrednt.CSV - Contains information about each ingredient, including 
the ID, name, unit type, ounces per unit, unit cost, whether or not it was 
selected, and the ingredient type.    This file only has about 900 records.

DrinkIng.CSV - combines the above two tables.    It has the drink ID, 
Ingredient ID, sequence, and amount for each ingredient of each drink.    
This is by far the largest file with over 21,000 records.



Merging Drink Lists

The Drink Merge feature exists for two reasons.    First, it is a simple 
way to exchange drinks between users of BarBack.    I have hopes that 
BarBack will become so popular that there will be web sites dedicated to 
swapping drink lists.    The second reason is so that there would be a way to 
get the drinks that you may have added in a previous version into the new 
version.    That is why the merge feature works with versions 2.0, 2.1, 3.0 
and 5.0.

In the top edit control is the location of the current drink database.    
This is the database that BarBack is currently using and is always found in 
the same directory as the executable file.

Below that is a space for you to type in the location and name of the 
new drink database that you want to merge.    Clicking on the button with 
the ... on it will bring up a file open dialog that will allow you to browse for 
the file you want.    If you downloaded the file from the internet or a BBS, 
the file is probably compressed.    Make sure that you uncompress the file 
before trying to merge it.    If you do not, the merge will tell you that the file 
is not in the proper format.

After selecting the file to merge, click on the OK button.    The merge 
will begin and will keep a running total of the number of drinks that were 
added and the drinks that were ignored.    

Drinks are added based only on their name.    If a drink with the same 
name exists, that drink will be ignored.    However, if a drink with the exact 
same ingredients, but a different name is found, that drink will be added 
simply because the name is different.



Unit Conversion and Reference

In an effort to make BarBack more useful to those people who use the 
metric system, BarBack now includes a unit conversion tool to convert 
English and metric measurements.    This conversion tool is limited to 
English and Metric units of fluid measurement only.

The unit conversion tool is found under the Unit Conversions option 
on the Tools menu.    It can convert English to metric, metric to English, 
English to English and metric to metric.

To use the conversion tool, first enter the amount that you want to 
convert.    Then select the units that the amount to be converted is in.    

Then select the units that you want to convert to.    The area with the 
converted amount will be filled in when you click on the Convert button.

Reference 

This is really just a collection of equivalent measurements for English,
metric, and other more esoteric units.    It includes the volume of beer kegs 
and cases, wine carafes, and standard liquor bottle sizes, among other 
things.



Glassware Reference

The following glass or container types are used in BarBack as the recommended container for 
each drink.

Beer Mug
For serving tap beer and drinks that use beer such as the Depth Charge or Dr. Pepper

Brandy Snifter
For serving fine liquor neat such as brandy, congnac, or Grand Mariner 

Champagne Flute
For serving champagne based drinks as well as some frozen drinks.

Cocktail Glass
For the serving of cocktails such as the Martini or Manhatten



Collins Glass (also called a chimney glass, tall glass)
A tall narrow glass for punches, fizzes, swizzles and coolers and other tall drinks.

Cordial Glass
A fancy shot glass that is fluted like the champagne glass but much smaller in volume.    

For the service of liquor neat as well as layerd cocktails.

Coupette Glass
A classic shape for the service of frozen drinks.

Highball Glass
Standard glass for the service of smaller mixed drinks such as highballs and double sours.

Hurricane Glass
A large exotic glass for large mixed or frozen tropical drinks.



Irish Coffee Cup
A heet tempered glass for the service of hot or coffee based drinks.

Margarita Glass
A bowl shaped glass for frozen drinks, especially the margarita.    Should fit in a standard 

margarita salter for salting the rim.

Mason Jar (also a canning jar)
Traditional container for moonshine and other illicit distilled beverages, can be used to 

serve lemonades and other whiskey based drinks.

Old Fashioned Glass
Smaller than a highball with sloped sides and a heavy, facteted bottom.    For serving liqor

on the rocks and for smaller mixed drinks.

Parfait Glass
For the service of frozen drinks or floats.



Pilsner Glass
For the service of beer on tap and for beer based drinks that do not require the use of a 

shot glass dropped into the beer.

Pitcher
For the mixing and serving drinks made in larger batches.    This includes drinks made in 

blenders where the final glassware is not specified.

Pousse-Cafe Glass
For the service of liquor neat and for layered drinks or pousse cafes.

Punch Bowl
For serving punches and other party type drinks.    Should be able to hold hot or cold 

liquid.

Red Wine Glass (also balloon glass or wine goblet)



For drinks based on red wine.

Sherry Glass
For sherry based drinks

Shot Glass
For the service of liquor neat and for the service of mixed drink meant to be consumed in 

a single swallow such as shooters or slammers.

Unknown Glass Type
Any glass or container that does not fit any other the other 23 types.    This is typically 

given to recipes for liqueurs, flavorings and extracts.

Whisky Sour Glass
A heavy faceted glass for the service of whiskey, sours and other small drinks.

White Wine Glass



For the service of white wine based drinks or wine coolers.



Layered Shot Guide

The following table shows the specific gravity (density relative to water) of    56 liquors and liqueurs.
You can use this guide to make layerd shots.    Liquors with a lower specific gravity will float on top of those with a 
higher gravity.

To make layerd shots (also called pousse cafes) start with the heavyest liquid and work your way up to the 
lightest.    To keep the layers separate in the glass, pour the liquor over a bar spoon or teaspoon held upsidedown.    
This will keep the liquor from flowing into the glass to quickly and mixing with the other ingredients.

NO. Proof Product Gravity Color
1 40 Creme de Cassis 1.1833 Purple
2 25 Grenadine Liqueur 1.1720 Red
3 54 Creme de Cacao 1.1561 Brown
4 48 Hazelnut Schnapps 1.1532 Tawny
5 40 Praline 1.1514 Brown
6 50 Praline Liqueur 1.1514 Brown
7 54 Creme de Cacao 1.1434 White
8 56 Creme de Noyaux 1.1342 Red
9 48 Licorice Schnapps 1.1300 Clear
10 54 Chocolate Cherry 1.1247 Brown
11 56 Creme de Banana 1.1233 Yellow
12 54 Chocolate Mint 1.1230 Brown
13 48 Blue Curacao 1.1215 Blue
14 54 Swiss Chocolate Almond 1.1181 Brown
15 25 Haagan-Daaz Peach 1.1160 White
16 60 Creme de Menthe, White 1.1088 White
17 60 Creme de Menthe, White 1.1088 Green
18 60 Orange Curacao 1.1086 White
19 34 Haagan-Daaz, Original 1.1037 Cream
20 34 Haagan-Daaz, Vanilla 1.1029 Cream
21 48 Cider Mill Apple Schnapps 1.0999 Tawny
22 48 Orchard Orange Schnapps 1.0998 Clear
23 60 Anissette, white & red 1.0987 White/Red
24 48 Creme de Strawberry 1.0986 Red
25 48 Wild Strawberry Schnapps 1.0966 Clear
26 40 Juicy Grape Schnapps 1.0933 Purple
27 48 Red Hot Schnapps 1.0927 Red
28 60 Triple Sec 1.0922 White
29 60 Rock & Rye 1.0887 Yellow
30 40 Cranberry Cordial 1.0872 Cranberry
31 50 Amaretto 1.0842 Tawny
32 48 Old Fashioned Rootbeer Schnapps 1.0828 Tawny
33 84 Sambuca 1.0813 White
34 40 Country Melon Schnapps 1.0796 Pink
35 70 Coffee Flavored Brandy 1.0794 Brown
36 48 Red Raspberry Schnapps 1.0752 Clear
37 48 Snappy Apricot Schnapps 1.0733 Tawny
38 48 Cinnamon Schnapps 1.0732 Red
39 48 Spearmint Schnapps 1.0727 Clear
40 60 Shamrock Schnapps 1.0617 Green
41 60 Peppermint Schnapps 1.0615 Clear
42 48 Jubilee Peach Schnapps 1.0595 Clear
43 70 Raspberry Brandy 1.0566 Red



44 70 Apricot Brandy 1.0548 Tawny
45 70 Peach Brandy 1.0547 Tawny
46 70 Cherry Brandy 1.0542 Red
47 70 Blackberry Brandy 1.0536 Purple
48 90 Peach Schnapps 1.0534 Clear
49 90 Root Beer Schnapps 1.0441 Brown
50 50 Amaretto & Cognac 1.0394 Tawny
51 60 Sol Y Sombra 1.0376 Tawny
52 90 Cinnamon Spice Schnapps 1.0358 Red
53 90 Peppermint Schnapps 1.0340 Clear
54 60 Sloe Gin 1.0241 Red
55 70 Ginger Brandy 0.9979 Light Brown
56 90 Kirschwasser 0.9410 Clear

Special thanks to Richard Byrnes, Jr. of    The Fermental Order of Renaissance Draughtsmen for supplying me with 
this list.



Drinking Quotes

Here is a collection of quotes that has been floating around the Internet for some time 
now.

Special thanks to Richard Byrnes, Jr. of    The Fermental Order of Renaissance Draughtsmen for 
forwarding the list to me.

Whoever makes a poor beer is transferred to the dung-hill.                                            
                Edict, City of Danzig, 11th Century                                                                          

Beer drinkin don't do half the harm as love-makin.                                                            
                Anonymous                                                                                                                              

Fermentation and civilization are inseparable                                                                      
                John Ciardi (1916-1986)                                                                                                  

Give me a woman who truly loves beer, and I will conquer the world.                          
                Kaiser Wilhelm II (1859-1941)                                                                                      

He who drinks beer sleeps well.                                                                                                  
He who sleeps well cannot sin.                                                                                                    
He who does not sin goes to heaven.                                                                                          
Amen.                                                                                                                                                      
                Unknown German Monk                                                                                                          

It is better to think of church in the ale-house than to think of the                      
ale-house in church.                                                                                                                        
                Martin Luther (1483-1546)                                                                                              

The selling of bad beer is a crime against Christian love.                                            
                Law, the City of Augsburg, 13th Century                                                                  

It is my design to die in the brew-house; let ale be placed to my mouth                  
when I am expiring, that when the choirs of angels come, they may say,                    
"Be God propitious to this drinker."                                                                                        
                Saint Columbanus, A.D. 612                                                                                            

From man's sweat and God's love, beer came into the world.                                            
                Saint Arnoldus                                                                                                                    

God made yeast, as well as dough, and loves fermentation just as dearly                  
as he loves vegetation.                                                                                                                  
                Ralph Waldo Emerson (1803-1882)                                                                                  

There are more old drunks than old doctors.                                                                          
                Anonymous                                                                                                                              

Of doctors and medicines we have in plenty more than enough...what you                    
may, for the Love of God, send is some large quantity of beer.                                    
                Dispatch from the Colony, New South Wales, 1854                                                  

The Puritanical nonsense of excluding children and -- therefore -- to                      



some extent women from pubs has turned these places into mere boozing                      
shops instead of the family gathering places that they ought to be.                          
                George Orwell (1903-1950)                                                                                              

Beer makes you feel the way you ought to feel without beer.                                          
                Henry Lawson                                                                                                                        

Wine is but single broth, ale is meat, drink, and cloth.                                                
                16th Century English Proverb                                                                                        

At social parties no gentleman ever thought of leaving the table sober;                  
the host would have considered it a slight on his hospitality.                                    
                F.W. Hackwood, comment on manners, 18th Century England                                  

Beer..."a high and mighty liquor"                                                                                              
                Julius Caesar                                                                                                                      

Of beer an enthusiast has said that it could never be bad, but that some                
brands might be better than others...                                                                                      
                A.A. Milne                                                                                                                            

Beer, of course, is actually a depressant, but poor people will never                      
stop hoping otherwise.                                                                                                                    
                Curt Vonnegut, Jr., Hocus Pocus, 1990                                                                      

He is not deserving the name of Englishman who speaketh against ale,                        
that is, good ale.                                                                                                                            
                George Borrow (1803-1881)                                                                                              

Ere's to English women an' a quart of English beer.                                                          
                Rudyard Kipling                                                                                                                  

There's nothing as heartening as the sight of an empty pub in the                              
morning, the shelves full and everything spick and span before the                            
barbarian hordes come in. Them that drinks bottles spoil the look of the                
shelves but draught is a different story - you never see the barrel                          
going down.                                                                                                                                          
                Patrick McGinley                                                                                                                

No poems can live long or please that are written by                                                        
water-drinkers.                                                                                                                                  
                Horace 65-8 B.C.                                                                                                                

Time is never wasted when you're wasted all the time.                                                      
              --Catherine Zandonella                                                                                                      

Abstainer: a weak person who yields to the temptation of denying himself                
a pleasure.                                                                                                                                          
              --Ambrose Bierce                                                                                                                  

Reality is an illusion that occurs due to the lack of alcohol.                                    

I never drink anything stronger than gin before breakfast.                                            

A woman drove me to drink and I didn't even have the decency to thank                      
her.                                                                                                                                                        



              --W.C. Fields                                                                                                                        

What contemptible scoundrel has stolen the cork to my lunch?                                        
              --W.C. Fields                                                                                                                        

Beauty lies in the hands of the beerholder.                                                                          

Sir, if you were my husband, I would poison your drink.                                                  
              --Lady Astor to Winston Churchill                                                                                
Madam, if you were my wife, I would drink it.                                                                      
              --His reply                                                                                                                            

If God had intended us to drink beer, He would have given us stomachs.                    
              --David Daye                                                                                                                          

Work is the curse of the drinking classes.                                                                            
              --Oscar Wilde                                                                                                                        

When I read about the evils of drinking, I gave up reading.                                          
              --Henny Youngman                                                                                                                  

Life is a waste of time, time is a waste of life,                                                              
so get wasted all of the time and have the time of your life.                                      

I'd rather have a bottle in front of me, than a frontal lobotomy.                              
              --Tom Waits                                                                                                                            

24 hours in a day, 24 beers in a case. Coincidence?                                                          

Beer is good food.                                                                                                                            

you don't like jail?                                                                                                                        
naw, they got the wrong kind of bars in there.                                                                    
              --Charles Bukowski                                                                                                              

If you ever reach total enlightenment while drinking beer, I bet it                          
makes beer shoot out your nose.                                                                                                  
              --Deep Thought, Jack Handy                                                                                              

It's better to have beer in hand than gas in tank.                                                            

Life is too short to drink cheap beer.                                                                                    

Beer - it's not just for breakfast anymore                                                                            

Beer: Nature's laxative.                                                                                                                

Beer. If you can't taste it, why bother!                                                                                

One more drink and I'd be under the host.                                                                              
              --Dorothy Parker                                                                                                                  

All other nations are drinking Ray Charles beer and we are drinking                          
Barry Manilow.                                                                                                                                    
              --Dave Barry                                                                                                                          



When I heated my home with oil, I used an average of 800 gallons a year.                
I have found that I can keep comfortably warm for an entire winter with                  
slightly over half that quantity of beer.                                                                              
              --Postpetroleum Guzzler, Dave Barry                                                                            

Without question, the greatest invention in the history of mankind is                      
beer.    Oh, I grant you that the wheel was also a fine invention, but the                
wheel does not go nearly as well with pizza.                                                                        
              --Dave Barry's Bad Habits, Dave Barry                                                                        

Not all chemicals are bad. Without chemicals such as hydrogen and                              
oxygen, for example, there would be no way to make water, a vital                              
ingredient in beer.                                                                                                                          
              --Dave Barry                                                                                                                          

My problem with most athletic challenges is training. I'm lazy and find                  
that workouts cut into my drinking time.                                                                                
              --A Wolverine is Eating My Leg                                                                                      

The problem with the world is that everyone is a few drinks behind.                          
              --Humphrey Bogart                                                                                                                

Friends don't let friends drink Light Beer.                                                                          

If nothing beats a Bud, given the choice, I'd take the nothing...                              

Draft beer, not people!                                                                                                                  

Adhere to Schweinheitsgebot. Don't put anything in your beer that a pig                  
wouldn't eat.                                                                                                                                      
              --David Geary                                                                                                                        

Why is American beer served cold? So you can tell it from urine.                                
              --David Moulton                                                                                                                    

A drink a day keeps the shrink away.                                                                                        
              --Edward Abbey                                                                                                                      

People who drink light "beer" don't like the taste of beer; they just                      
like to pee a lot.                                                                                                                            
              --Capital Brewery, Middleton, WI                                                                                  

Put it back in the horse!                                                                                                              
              --H. Allen Smith, an American humorist in the '30s-'50s, after he                
                  drank his first American beer at a bar.                                                                



Disclaimer

This Software is meant for people of legal drinking age.  It does not in any way promote under 
age drinking, excessive drinking, hazing or other abuses of alcohol.  

The drinks in the BarBack database have been compiled from many publicly available sources as
well as from user submissions.  I obviously have not tried each and every drink.  If you feel that 
a drink is not appropriate, please do not make it or drink it.  If you are a bartender, please 
remember your professional responsibility to keep your customers safe.  Many drinks in BarBack
are not portioned for use in a commercial bar or tavern.  I cannot be held responsible for any 
damages that my occur in the use of this guide.  I have faith in your common sense, that you will 
use this guide responsibly.

BarBack is not sponsored by, endorsed by or promoted by any particular liquor company or 
distributor.  All brand names mentioned in BarBack are copyrighted by or trademarks of their 
respective owners.  

If you are going to drink, please never drive.  If you know someone who has been drinking, 
never let him or her drive.



Cheers!

Special thanks to Richard Byrnes, Jr. of    The Fermental Order of Renaissance Draughtsmen for supplying me with 
this list.

Country Toast Pronunciation Translation
Bahamas Cheers
Bali Selemat say-lamat
Brazil Saude sa-ood-eh A Salute to you!
Bulgaria Nazdrave nahz-drove-eh To your health!
China Kan pei kan-pei (Gan-Bei?) Drain the Glass!
Czech Na Zdravi Nahz drah vee To your health!
Denmark Skøl skol A salute to you!
Finland Kippis Cheers!
France A votre sante ah vote    santay To your Health
France A le votre Ah leh vote And to yours (response)
Germany Prosit pro-zit Cheers!
Greece Stin Ygai-sou Stin ee-ya-soo To your Health!
Hawaii Kamau kama-u Here's how!
Hungary Egeszsegedre To your Health
Iceland Skal skol A salute to you!
Ireland Slainte slauntca Cheers, to your health.
Ireland Slainte is Saul agat (Slauwne-cheh-iss sole agat)    Health & life to you
Israel L'chaim la-kiam To life!
Italy Alla tua salute To your health!
Italy Cin-cin All good things for you!
Japan Kan pai kan-pie Bottoms up
Kenya Kwa afya yako kwa-afee-ya yah-ko ?
Korea Gun bai kun buy Bottoms up
Malaysia Yam seng yam seng ?
Mexico Salud sah-lood Health
Morocco Sahrtek sah-tek To your health!
Norway Skøl skol A salute to you!
Philippines Mubuhay Mah-boo-hay Long life!
Poland Na zdrowie nahz-drove-eh To your health
Portugal A sua saude To your health!
Romania Noroc Good luck!
Russia Za vashe z-dorovye To your health!
Saudia Arabia Hanian Congratulations!
Scotland Slainte mhoiz Good health!
Singapore Yam seng To your continuing success!
Spain Salud sah-lood To your health!
Sweden Skal skol A salute to you!
Tanzania Kwa afya yako kwa-afee-ya yah-ko
Thailand Chai yo ch-aye yog Victory!
Thailand ?? Chook-Dee Good Luck!
Turkey Serefinize ser-ay-fin-eeze To your honor!
Uruguay Salud sah-lood To your Health!
Wales Hwyll Hoyle Best of luck, Have fun, cheers
Wales(2) Lechyd da Yacki da God be with you
Wales(2) (response) ...........Bo-Bein And with you!
Yugoslavia Ziveli shiv-elli To your health!



Registration Form

The registered version of BarBack 5.0 does not have the annoying guilt messages at the start and end of the 
program and includes printing and export features.

To register your copy of BarBack 5.0, fill out this form and send it along with a check or money order 
(payable to Paul Knorr) to:

Paul Knorr
Interworld Software
11 Evert Street
Huntington Station, NY    11746-3507 USA

Please Print

Name: _______________________________________

Address: _______________________________________

_______________________________________

_______________________________________

E-Mail _______________________________________

How Did you hear about BarBack (please be as specific as possible)?

________________________________________________________________________

________________________________________________________________________

# Copies ________________________

Total ($40.00 / copy) ________________________

Please make the check or money order payable to Paul Knorr.    Please, for your protection, do 
not send cash.




